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Premiers pas 
Bienvenue dans Final Draft, leader mondial des logiciels de rédaction de scripts. 
Outre son interface conviviale, ce programme abrite de puissantes fonctionnalités de 
rédaction de scripts et de production. Final Draft permet de passer très simplement 
de l’idée aux grandes lignes, puis de la première à la dernière mouture et enfin au 
script de production. Final Draft a été con�u en collaboration avec des 
professionnels du monde entier, ceux-là même qui élaborent vos œuvres 
cinématographiques et télévisuelles préférées. Il propose des formats adaptés aux 
scénarios de films, de sitcoms et de pièces de théâtre. Grâce à Final Draft, qui 
insère automatiquement chaque élément de script au bon endroit, vous pouvez vous 
concentrer sur l’écriture plut™t que sur la mise en page de vos idées.  
 
Final Draft International Edition comporte un vérificateur d’orthographe et un thésaurus 
pour l’anglais américain et pour 17 autres langues (le thésaurus n’est pas disponible 
dans toutes les langues). Il est fortement recommandé de lire la section 
Personnalisation ci-après pour savoir comment optimiser le fonctionnement de Final 
Draft dans la langue et les formats de votre choix. 
 
Final Draft offre une compatibilité sans équivalent avec la plupart des plates-formes. 
Parce qu’ils utilisent des formats de fichiers identiques, les scripts rédigés sur les 
ordinateurs Windows® peuvent être lus et modifiés sur les ordinateurs Macintosh® 
et inversement.  
 
Final Draft propose un grand choix de fonctionnalités : révisions illimitées, 
verrouillage des pages, possibilité de partager votre script avec plusieurs personnes 
via Internet pour l’afficher, le modifier et le commenter, de nombreux types de 
rapports et un puissant traitement de texte de type WYSIWYG (î tel écrit, tel écran î). 
 
Final Draft est livré avec Tagger -The Final Draft Breakdown Utility, une application 
de découpage distincte. Ce logiciel permet de baliser les éléments d’un script pour 
qu’ils soient réutilisés par des programmes de découpage et de planification de 
scripts. 
 
Pour toute question ou problème concernant Final Draft, consultez en premier lieu le 
Centre d’assistance de Final Draft à l’adresse www.finaldraft.com/help. Vous y 
trouverez la Base de connaissances de Final Draft. Il s’agit d’une base de données 
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interactive en anglais, disponible en ligne 24h/24 et 7j/7. Elle contient une FAQ (foire 
aux questions), des solutions aux problèmes des utilisateurs, des conseils et des 
informations générales sur Final Draft et nos autres produits. Si le problème persiste, 
vous pouvez envoyer un courrier électronique à notre Service client par 
l’intermédiaire de la Base de connaissances de Final Draft (en anglais). Les 
questions dans une autre langue que l’anglais ne feront l’objet d’aucune réponse. 
Pour obtenir des détails complets, consultez les Politiques du Service client. Le 
Service client est réservé exclusivement aux utilisateurs de Final Draft référencés. 
 

REMARQUE :  Avant d’envoyer un courrier électronique ou d’appeler le Service 
client, munissez-vous de votre numéro de client. Il se trouve sur le panneau arrière 
de la pochette du disque d’installation de Final Draft International Edition (ou dans 
votre courrier électronique de commande si vous avez installé une version 
téléchargée). 
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Package de Final Draft International Edition 
 
Disque d’installation de Final Draft International Edition 
La pochette du disque de Final Draft International Edition contient un cd-rom 
d’installation du programme Final Draft, ainsi qu’un vérificateur d’orthographe 
supplémentaire (et un thésaurus dans la plupart des cas) pour les systèmes 
Windows et Macintosh. Il inclut également le manuel Final Draft User Guide (en 
anglais uniquement), ainsi que le manuel Premiers pas en anglais, fran�ais, 
allemand et espagnol. 

 
Numéro de client 
Ce numéro est imprimé sur le panneau arrière de la pochette du disque de Final 
Draft International Edition. Il est nécessaire à l’installation, au référencement et à 
l’activation du programme. 

 

REMARQUE :  Si vous avez obtenu votre copie de Final Draft International Edition 
par téléchargement, votre numéro de client est inclus dans le courrier électronique 
de commande. Il est fortement recommandé d’en imprimer une copie pour référence. 

 
 Il est fortement recommandé de : 
 Décoller un numéro de client sur le panneau arrière de la pochette du disque et 

de le coller  sur la carte de référencement ; 
  
  – et de – 
 
 Décoller un numéro de client sur le panneau arrière de la pochette du disque et 

de le coller dans le manuel Premiers pas. 
 
Carte de référencement 
L’accès au Service client, aux mises à jour, etc., est réservé exclusivement aux 
utilisateurs de Final Draft référencés. Référencez-vous en ligne ou envoyez-nous 
votre carte de référencement par courrier ou par télécopie après y avoir collé l’un des 
numéros de client figurant sur le panneau arrière de la pochette du disque. 
 
Manuel Premiers pas 
Ce document, qui décrit les procédures d’installation et de lancement de Final Draft 
International Edition, comprend également des didacticiels de base en anglais, 
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fran�ais, allemand et espagnol. Lors de l’installation de Final Draft International 
Edition, la version complète du manuel Final Draft User Guide (en anglais uniquement) 
et une version multilingue du manuel Premiers pas sont ajoutées au format PDF sur 
votre ordinateur. 
 

REMARQUE :  Toute la documentation de Final Draft comprend des instructions 
d’utilisation du logiciel sur les plates-formes Microsoft Windows® et Mac OS™. Les 
différences de fonctionnalités, de commandes et de procédures entre ces plates-
formes sont signalées dans le texte. 
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Vous devez disposer d’une connaissance pratique de votre ordinateur et de son 
système d’exploitation. Par exemple, vous devez savoir utiliser une souris, des 
menus et des commandes standard, mais aussi ouvrir, copier, enregistrer et fermer 
des fichiers. Pour obtenir des instructions complètes, reportez-vous à la 
documentation de Windows ou Mac OS. 
 

REMARQUE :  Final Draft est constamment mis à jour et il s’enrichit de nouvelles 
fonctionnalités, généralement grâce aux remarques de ses utilisateurs. La structure 
des menus et même les commandes peuvent changer. Si vous rencontrez des 
commandes non expliquées, ouvrez le dossier Final Draft et recherchez le fichier î 
Read Me î ou î New Features î. Ces fichiers texte présentent les nouvelles 
fonctionnalités du programme. Vous pouvez également consulter notre site Web 
www.finaldraft.com pour obtenir les ultimes informations et fichiers à télécharger. 
 
Installation, lancement, référencement et activation 
Que vous utilisiez un ordinateur Windows ou Macintosh, les procédures 
d’installation, de lancement, de référencement et d’activation sont identiques. Vous 
trouverez ci-après un descriptif de chaque opération. 
 

REMARQUE :  Votre numéro de client, situé sur le panneau arrière de la pochette 
du disque de Final Draft International Edition (version cd-rom) ou inclus dans le 
courrier électronique de commande (version en téléchargement) est indispensable 
pour l’activation et le référencement. 

INSTALLATION LANCEMENT RÉFÉREN-
CEMENT

ACTIVATION
SAISIEDU

NUMÉRODE
CLIENT

NOUVEAU
SCÉNARIO

VIERGE

 
 
Comme pour la plupart des logiciels, c’est au cours de l’installation que l’application 
Final Draft et les fichiers associés (notamment les vérificateurs d’orthographe pour 
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les différentes langues) sont copiés sur votre ordinateur. Le lancement correspond 
au premier démarrage du programme et à la saisie de votre numéro de client. 
 
Seuls les utilisateurs de Final Draft référencés peuvent bénéficier des nombreux 
services que nous proposons. Votre numéro de client est nécessaire au 
référencement, qui peut être réalisé en ligne, par courrier ou par télécopie. 
 
Pour utiliser Final Draft pendant plus de 15 jours, vous devez l’activer. Lors de 
l’activation, nous vérifions que votre numéro de client (sur le panneau arrière de la 
pochette du disque de Final Draft International Edition pour la version sur cd-rom ou 
dans le courrier électronique de commande pour la version en téléchargement) est 
authentique et qu’il n’a pas été activé sur plus d’ordinateurs que ne le permet votre 
Contrat de licence utilisateur. En outre, une étape de personnalisation facultative 
peut s’avérer nécessaire en fonction des paramètres de langue que vous avez 
sélectionnés. 

REMARQUE :  Lors de l’installation de Final Draft International Edition, le 
programme d’installation vous guide à travers chaque étape du processus.  
 

REMARQUE :  Vous pouvez vous référencer dès le premier lancement de Final 
Draft ou à une date ultérieure. 
 

REMARQUE :  Tagger est une application distincte ajoutée pendant l’installation 
de Final Draft. 
 
Pour obtenir des détails complets, consultez les sections ci-après. 
 
Installation 
Au cours du processus d’installation, vous pouvez installer le vérificateur 
d’orthographe et, dans la plupart des cas, le thésaurus d’une langue supplémentaire. 
Les langues suivantes sont disponibles : 
Anglais britannique Italien 

Anglais canadien Norvégien 

Fran�ais canadien Polonais (aucun thésaurus) 
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Catalan (aucun 
thésaurus) 

Portugais (continental) (aucun 
thésaurus) 

Danois Portugais (brésilien) (aucun thésaurus)

Néerlandais Espagnol 

Finnois (aucun thésaurus) Suédois 

Fran�ais Suisse allemand 

Allemand  

 

REMARQUE :  Pour installer plusieurs langues supplémentaires, vous devez les 
acquérir séparément. Pour conna”tre la procédure de commande ou les tarifs, 
consultez le site Web de Final Draft Inc. à l’adresse www.finaldraft.com ou 
téléphonez au +1.800.231.4055 ou +1.818.995.8995. 
 
Windows 

REMARQUE IMPORTANTE :  Windows NT/2000/XP uniquement – Vous devez être 
connecté en tant qu’administrateur pour installer Final Draft International Edition. Si 
vous n’êtes pas administrateur, contactez la personne chargée de la maintenance de 
votre réseau ou de votre parc informatique. 
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REMARQUE IMPORTANTE :  Si vous installez ce programme sur un ordinateur 
équipé d’une version précédente de Final Draft, vous ne devez pas l’installer dans le 
dossier contenant cette version. En cas de doute, installez Final Draft International 
Edition dans l’emplacement par défaut suggéré par le programme d’installation. 
 
Pour installer Final Draft lorsque la fonctionnalité Windows d’exécution automatique 
des cdrom est activée : 
1 Insérez le disque d’installation de Final Draft International Edition dans le lecteur. 
 
L’exécution automatique démarre. 
 
2 Double-cliquez sur Install Final Draft. Passez à l’étape 5 ci-dessous. 
 
Pour installer Final Draft lorsque la fonctionnalité Windows d’exécution automatique 
des cdrom est désactivée : 
1 Insérez le disque d’installation de Final Draft International Edition dans le lecteur. 
 
2 Ouvrez (double-cliquez sur) Poste de travail. La fenêtre Poste de travail apparaît. 
 
 Windows XP  
 Cliquez sur Démarrer > Poste de travail. 
 
3 Parcourez l’arborescence jusqu’au disque d’installation de Final Draft 

International Edition. 
 
4 Ouvrez (double-cliquez sur) Setup.exe. 
 
5 La fenêtre d’accueil du programme d’installation apparaît.  
 
6 Sélectionnez le vérificateur d’orthographe (et le thésaurus dans la plupart des 

cas) pour la langue supplémentaire que vous souhaitez installer en plus de ceux 
pour l’anglais américain. 

 
7 Cliquez sur Install. 
 



FINAL DRAFT INTERNATIONAL EDITION 
 

9 – Premiers pas 
 
 
 

 

8 Acceptez le dossier de destination par défaut ou sélectionnez-en un autre. 
Cliquez sur Next. 

 

AVERTISSEMENT :  Il est fortement recommandé d’installer Final Draft 
uniquement dans le dossier de destination par défaut. 
 
9 L’écran Ready to install apparaît. Cliquez sur Next. L’installation de Final Draft 

débute. 
 
Un écran apparaît pour indiquer que l’installation a réussi. 
 
10 Cliquez sur Finish. 
L’assistant d’installation du vérificateur d’orthographe (et du thésaurus dans la 
plupart des cas) pour la langue supplémentaire apparaît. 
 
11 Cliquez sur Next. 
 
12 Acceptez le dossier de destination par défaut ou sélectionnez-en un autre si vous 

avez agi ainsi pour le programme de Final Draft. Cliquez sur Next. 
 

AVERTISSEMENT :  Il est fortement recommandé d’installer Final Draft 
uniquement dans le dossier de destination par défaut. 
 
13 L’écran Ready to install apparaît. Cliquez sur Next. L’installation du vérificateur 

d’orthographe (et du thésaurus dans la plupart des cas) pour la langue 
supplémentaire débute. 

 
Un écran apparaît pour indiquer que l’installation a réussi. 
 
14 Cliquez sur Finish. 
 
Pour votre confort, des raccourcis vers Final Draft 7 et Final Draft Tagger sont 
insérés dans le menu Démarrer > Programmes ou (Windows XP) Démarrer > Tous 
les programmes. 
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Pour plus d’informations sur l’utilisation du vérificateur d’orthographe et du thésaurus 
dans la langue supplémentaire, consultez la section Personnalisation ci-après. 
 
Macintosh 

REMARQUE IMPORTANTE :  Vous devez être connecté en tant qu’administrateur 
pour installer Final Draft International Edition. Si vous connaissez le mot de passe 
administrateur, utilisez-le pour vous connecter. Si vous ne le connaissez pas, 
contactez la personne chargée de la maintenance de votre réseau ou de votre parc 
informatique. 
 

REMARQUE IMPORTANTE :  Si vous installez ce programme sur un ordinateur 
équipé d’une version précédente de Final Draft, vous ne devez pas l’installer dans le 
dossier contenant cette version. En cas de doute, installez Final Draft International 
Edition dans l’emplacement par défaut suggéré par le programme d’installation.  
 
1  Insérez le disque d’installation de Final Draft International Edition dans le lecteur. 
 
2 La fenêtre de Final Draft International Edition apparaît. 
 
3 Double-cliquez sur le programme d’installation de Final Draft. 
 
4 La fenêtre d’accueil du programme d’installation apparaît. Cliquez sur Continue. 
 
5 Dans la fenêtre contextuelle de sélection, choisissez le vérificateur d’orthographe 

(et le thésaurus dans la plupart des cas) pour la langue supplémentaire que vous 
souhaitez installer en plus de ceux pour l’anglais américain. 

 
6 Acceptez le dossier de destination par défaut ou sélectionnez-en un autre.  
 

AVERTISSEMENT :  Il est fortement recommandé d’installer Final Draft 
uniquement dans le dossier de destination par défaut. 
 
7 Cliquez sur Install. 
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8 L’installation de Final Draft et du vérificateur d’orthographe (plus du thésaurus 

dans la plupart des cas) pour la langue supplémentaire débute. 
 
Lorsque l’installation est terminée, le dossier Final Draft 7 s’ouvre et affiche son 

contenu. 
 
Pour plus d’informations sur l’utilisation du vérificateur d’orthographe et du thésaurus 
dans la langue supplémentaire, consultez la section Personnalisation ci-après. 
 
Premier lancement de Final Draft 7 
 
Windows 
1 Cliquez sur le bouton Démarrer. Dans le menu Démarrer, cliquez sur 

Programmes ou (Windows XP) Tous les programmes. 
 
2 Dans le sous-menu Programmes, cliquez sur Final Draft 7. Passez à l’étape 3 

ci-dessous. 
 
Macintosh 
1 Ouvrez le dossier Final Draft 7. 
 
2 Ouvrez (lancez) Final Draft 7. 
 
 
3 Après l’écran de démarrage de Final Draft, le Contrat de licence utilisateur 

apparaît.  
 Cliquez sur Accept. 
 
4 L’écran de bienvenue apparaît. Saisissez votre numéro de client.  
 
5 Cliquez sur Continue (Windows) ou OK (Mac OS). 
(Windows) L’écran Activation apparaît, suivi de l’écran Registration. 
(Mac OS) L’écran Registration apparaît, suivi de l’écran Activation. 



FINAL DRAFT INTERNATIONAL EDITION 
 
12 – Premiers pas 
 
 

 

Activation 
 

REMARQUE :  Les ordinateurs qui ont été activés pour Final Draft 5 ou 6 doivent 
être de nouveau activés pour Final Draft 7. 
 

REMARQUE :  Vous pouvez à tout moment procéder à l’activation de vos deux 
ordinateurs autorisés. 
 
Pour activer votre ordinateur : 
6 Cliquez sur Online Activation ou Manual Activation. 
– ou – 
 Dans un délai de 15 jours suivant la première exécution de Final Draft, cliquez 

sur Help > Activate, puis sur Online Activation ou Manual Activation. 
 
Pour plus d’informations sur l’activation, consultez la section Activation, 
référencement et désactivation – FAQ ci-après. 
 
Activation en ligne 

REMARQUE :  Assurez-vous que vous disposez d’une connexion Internet, car 
vous devrez vous connecter pour finaliser l’activation. Cette procédure ne nécessite 
pas l’emploi d’un navigateur Internet. 
 
1 Cliquez sur Online Activation. 
 
2 Vous êtes automatiquement connecté au service d’activation en ligne de Final 

Draft. 
 
Votre ordinateur est activé et vous pouvez utiliser Final Draft sans restrictions. 
 

REMARQUE :  Si l’activation en ligne échoue, le système vous demande de 
contacter le Service client et d’effectuer une activation manuelle. 
 
Activation manuelle 
1 Cliquez sur Manual Activation. 
 



FINAL DRAFT INTERNATIONAL EDITION 
 

13 – Premiers pas 
 
 
 

 

Le code challenge de votre ordinateur apparaît. 
 
2 Appelez le Support technique au +1.888.320.7555 (hors des ƒtats-Unis et du 

Canada, appelez le +1.818.906.8930). Un service audiotel automatique vous 
guide à travers les étapes du processus. L’appel du service d’activation manuelle 
est entièrement gratuit. 
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REMARQUE IMPORTANTE :  Lorsque vous nous appelez, affichez votre code 
challenge à l’écran et préparez votre numéro de client. Si le code challenge n’est 
plus affiché à l’écran, il n’est plus valide. 
 
3 Vous recevez un code réponse. 
 
4 Saisissez le code réponse et cliquez sur Activate. 
 
Votre ordinateur est activé et vous pouvez utiliser Final Draft sans restrictions. 
 
Référencement 
Seuls les utilisateurs de Final Draft référencés peuvent bénéficier des nombreux 
services que nous proposons, notamment l’accès au Service client et aux mises à 
jour du programme. Votre numéro de client, situé sur le panneau arrière de la 
pochette du disque (dans le package de Final Draft International Edition) ou inclus 
dans le courrier électronique de commande (version en téléchargement) est 
indispensable pour le référencement, qui peut être réalisé à tout moment en ligne, 
par courrier ou par télécopie. 
 

REMARQUE IMPORTANTE :  Même si vous avez référencé une version antérieure 
de Final Draft, vous devez référencer Final Draft 7. 
 

REMARQUE IMPORTANTE :  Si vous avez déjà référencé Final Draft 7, vous ne 
devez pas recommencer. Ignorez cet écran en cliquant sur Register Later. 
 
Il est fortement recommandé de : 
 Décoller un numéro de client sur le panneau arrière de la pochette du disque et 

de le coller sur la carte de référencement ; 
 

 Décoller un numéro de client sur le panneau arrière de la pochette du disque et 
de le coller dans le manuel Premiers pas ; 

  
 Si vous avez obtenu votre copie de Final Draft par téléchargement, imprimez 

votre courrier électronique de commande et conservez-le en lieu sžr. 
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AVERTISSEMENT :  N’inscrivez pas votre numéro de client sur le cd-rom sous 
risque de l’endommager. 
 
Pour référencer Final Draft par voie électronique : 

 REMARQUE :  Assurez-vous d’être connecté à Internet. 
 
5 Pour vous référencer, renseignez le formulaire en ligne. Cliquez sur Register. 
 – ou –  
 Cliquez sur Register Later. 
 

Pour vous référencer par voie électronique à un autre moment : 
 Ouvrez Final Draft et cliquez sur Help > Register. 
 – ou –  
 Accédez au site Web de Final Draft à l’adresse www.finaldraft.com/register, 
cliquez sur Final Draft et suivez toutes les instructions pour remplir intégralement 
le formulaire de référencement. 
 
Pour vous référencer par courrier : 
Remplissez intégralement la carte de référencement jointe et envoyez-la à 
l’adresse figurant sur la carte.  
 

REMARQUE IMPORTANTE :  Décollez un numéro de client sur le panneau 
arrière de la pochette du disque et collez-le sur la carte de référencement avant 
l’envoi. 

 
Pour vous référencer par télécopie : 
Remplissez intégralement la carte de référencement jointe et envoyez-la par 
télécopie au +1.818.995.4422.  
 

REMARQUE IMPORTANTE :  Décollez un numéro de client sur le panneau 
arrière de la pochette du disque et collez-le sur la carte de référencement avant 
l’envoi. 
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Désactivation 
Une fois que Final Draft est activé sur un ordinateur, il peut s’avérer nécessaire de le 
désactiver. Par exemple, vous pouvez avoir besoin de reformater le disque dur ou de 
changer d’ordinateur.  
 

 AVERTISSEMENT :   Si vous reformatez votre disque dur avant d’annuler 
l’activation, celle-ci est perdue. 
 
Vous pouvez supprimer une activation à tout moment grâce au processus dit de î 
désactivation î. 
 
Pour désactiver votre ordinateur : 
1 Ouvrez Final Draft et cliquez sur Help > Deactivate. 
 
2 Cliquez sur Online Deactivation ou Manual Deactivation. 
 
Désactivation en ligne 

REMARQUE :  Assurez-vous que vous disposez d’une connexion Internet, car 
vous devrez vous connecter pour finaliser la désactivation. 
 
1 Cliquez sur Online Deactivation. 
2 Vous êtes connecté au service de désactivation en ligne de Final Draft. 
 
Votre ordinateur est désactivé. Votre compte est crédité de sorte que vous puissiez 
activer un autre ordinateur à tout moment. 
 

REMARQUE :  Si la désactivation échoue, le système vous demande de contacter 
le Service client et d’effectuer une désactivation manuelle (voir ci-après). 
 
Désactivation manuelle 
1 Cliquez sur Manual Deactivation. 
 
Le code de désactivation de votre ordinateur apparaît. 
 
2 Notez le code de désactivation. 
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3 Envoyez un courrier électronique contenant le code de désactivation à l’adresse 

deactivate@finaldraft.com. 
 
Vous devez également inclure dans le courrier électronique : 
 
- le code de désactivation, 
 
- votre nom (tel que vous l’avez saisi lors du référencement de Final Draft), 
 
- votre numéro de client, situé sur le panneau arrière de la pochette du disque (dans 
le package de Final Draft International Edition), inclus dans le courrier électronique 
de commande (version en téléchargement) ou affiché lorsque vous cliquez sur Help 
> Customer Support. 
 
Une fois que le Service client a traité votre demande de désactivation, vous recevez 
un courrier électronique de confirmation et pouvez activer un autre ordinateur. 
 
Utilisation de Final Draft 7 après le premier lancement 
 
Windows 
1 Cliquez sur le bouton Démarrer. Dans le menu Démarrer, cliquez sur 

Programmes ou (Windows XP) Tous les programmes. 
 
2 Dans le sous-menu Programmes, cliquez sur Final Draft 7. Passez à l’étape 3 

ci-dessous. 
 
 
Macintosh 
1 Ouvrez le dossier Final Draft 7. 
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2 Ouvrez (lancez) Final Draft 7. 
 
3 Si vous n’avez pas activé Final Draft : 
 Un écran apparaît pour vous informer du nombre de jours restants avant que 

l’activation 
 devienne obligatoire. 
 
 Cliquez sur Activate Now (voir les pages précédentes). 
 – ou –  
 Cliquez sur Activate Later.  
 
Une fenêtre de script vierge apparaît, dans laquelle vous pouvez commencer la 
saisie. 
 
Activation, référencement et désactivation – FAQ 
Qu’est-ce que l’activation du produit ? 
L’activation du produit est un processus simple et anonyme qui permet d’authentifier 
les utilisateurs de Final Draft titulaires d’une licence valide. Il vérifie que le numéro 
de client est authentique et qu’il n’a pas été activé sur plus d’ordinateurs que ne le 
permet le Contrat de licence utilisateur de Final Draft. 
 
Que se passe-t-il pendant l’activation du produit ? 
Votre numéro de client est authentifié par le système d’activation de Final Draft en 
vue d’activer votre copie du programme. L’ensemble du processus d’activation, qui 
peut être réalisé par Internet ou par téléphone, est simple et rapide. 
 
Quand dois-je activer mon produit ? 
Vous devez activer votre produit dans un délai de 15 jours après l’installation.  
 
Que se passe-t-il si je n’active pas mon produit ? 
Si vous n’activez pas votre produit dans un délai de 15 jours après l’installation, il 
s’arrête de fonctionner jusqu’à l’activation. 
 
Je ne possède aucun numéro de client pour activer mon logiciel. Comment 
puis-je m’en procurer un ? 
Un numéro de client est inclus avec votre achat. Il se situe sur le panneau arrière de 
la pochette du disque. Si vous ne possédez pas ce numéro, veuillez nous contacter.  
 
Comment puis-je activer mon produit ? 
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Vous pouvez activer votre produit 24h/24 et 7j/7, soit par Internet, soit en appelant le 
service audiotel automatique au +1.818.906.8930. Ces deux procédures sont à la 
fois simples et rapides. L’activation par Internet requiert la saisie de votre numéro de 
client. L’activation par téléphone requiert la saisie d’un code d’activation (affiché sur 
l’écran de votre ordinateur) dans un système audiotel automatique. 
 
Comment fonctionne l’activation du produit ? 
Ce processus utilise un nombre limité d’informations sur le produit et le système afin 
de solliciter une autorisation d’activation. Si la demande est validée, Final Draft 
re�oit un message qui lui permet de fonctionner intégralement et immédiatement. 
 

REMARQUE IMPORTANTE :  Le processus d’activation est 100 % anonyme et ne 
sollicite, ne collecte ou ne transmet aucune information personnelle. Il n’analyse pas 
votre disque dur et aucune des informations recueillies ne peut être utilisée pour 
vous identifier ou identifier votre ordinateur. 
 
Qu’advient-il si je possède plusieurs ordinateurs ?  
Vous pouvez installer, activer et utiliser Final Draft sur deux (2) ordinateurs dont 
vous êtes le propriétaire et l’exploitant. Toutefois, vous pouvez si nécessaire 
déplacer une activation d’un ordinateur à un autre. Il n’est pas possible d’utiliser une 
activation sur un ordinateur dont vous n’êtes pas le propriétaire et l’exploitant. 
 
L’activation du produit est-elle identique au référencement du produit ? 
Ce sont deux procédures distinctes. L’activation du produit est un processus 
obligatoire et anonyme qui vérifie votre numéro de série et votre licence. En 
revanche, le référencement du produit est un processus volontaire qui vous permet 
d’accéder au Service client, aux mises à jour du programme et aux offres spéciales 
de Final Draft.  
 
Quelles sont les informations requises pour le référencement du produit ? 
Le référencement du produit est un processus volontaire qui nécessite uniquement 
votre nom, votre adresse de messagerie électronique et votre numéro de client. À 
votre convenance, vous pouvez également nous communiquer certaines données 
démographiques. 
 
Combien de temps faut-il pour activer le produit ? 
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L’activation du produit est un processus unique, généralement effectué dès 
l’installation du logiciel. L’activation par Internet dure entre 10 et 30 secondes. 
L’activation par téléphone dure environ 5 minutes. 
 
Qu’est-ce que la désactivation et quand dois-je l’effectuer ?  
Comme l’activation, la désactivation peut être effectuée à tout moment. Par exemple, 
pour installer Final Draft sur un nouvel ordinateur, vous devez désactiver l’ancien 
ordinateur, puis activer le nouveau afin de transférer l’activation sur celui-ci. En 
outre, si vous prévoyez de reformater le disque dur d’un ordinateur activé, vous 
devez le désactiver avant le formatage et le réactiver ensuite. Si vous mettez à 
niveau votre système d’exploitation, il est recommandé de désactiver 
temporairement votre ordinateur. 
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Politiques du Service client 
 

  REMARQUE :  Vous devez être référencé pour bénéficier de notre Service client.  
Gratuit 
Consultez la Base de connaissances en ligne de Final Draft, qui contient plus de 800 
réponses aux questions les plus fréquemment posées au Service client. Visitez le 
site Web : www.finaldraft.com/help. 
 
Pour obtenir une assistance par courrier électronique via la Base de connaissances 
en ligne (anglais uniquement), visitez le site Web www.finaldraft.com/help et cliquez 
sur Ask a Question. Vous recevrez l’aide personnelle d’un représentant du Service 
client. Le délai de réponse pendant les horaires de bureau est généralement de 
deux heures. À défaut, vous recevrez une réponse sous un jour ouvrable. Les 
questions dans une autre langue que l’anglais ne feront l’objet d’aucune réponse. 
 
À compter de la date du référencement, vous bénéficiez d’un total de 20 minutes 
d’assistance téléphonique gratuite pendant 90 jours (voir ci-après). 
 
Assistance téléphonique 
L’assistance téléphonique est disponible 24h/24 et 7j/7, périodes de vacances 
incluses, via un numéro gratuit aux ƒtats-Unis et dans presque tout le Canada. 
 
Numéro d’assistance pour les ƒtats-Unis et la majorité du Canada : 1.888.320.7555. 
 
Numéro d’assistance hors des ƒtats-Unis et du Canada : +1.818.906.8930 (le cas 
échéant, cožt d’un appel international). 
 

 REMARQUE IMPORTANTE :  À compter de la date du référencement, vous 
bénéficiez d’un total de 20 minutes d’assistance téléphonique gratuite pendant 90 
jours. 
 
Une fois que vous avez épuisé votre crédit de 20 minutes d’assistance gratuite (ou 
passé le délai de 90 jours), chaque appel au Service client est facturé 2,50 USD la 
minute, payable par carte bancaire. La première minute d’appel est gratuite. Elle 
nous permet de vérifier votre numéro de client et vos informations de référencement. 
Lors de votre appel, vous devez vous munir de votre numéro de client et des 
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références de votre carte bancaire. Notre système audiotel vous demandera de 
saisir ces informations sur le clavier de votre téléphone.  
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Personnalisation 
Final Draft est un programme extrêmement souple. Il peut être personnalisé pour 
répondre à la plupart de vos besoins de mise en forme de scripts. Presque tous les 
paramètres de Final Draft sont modifiables.   
 
Final Draft étant spécialement con�u pour la rédaction de scénarios de style 
hollywoodien, il convient de noter un certain nombre de points sur l’usage de ses 
polices Courier, de sa fonctionnalité de lecture vocale et de son didacticiel de 
script. Le présent document traite également des vérificateurs d’orthographe et 
thésaurus pour les langues supplémentaires, des éléments, de la mise en forme 
des pages, de l’insertion des suites et des macros.   
 
Une fois la personnalisation terminée, vous pouvez créer des modèles pour 
réutiliser leurs paramètres spécifiques dans d’autres scripts. 
 
Remarques particulières à propos de Final Draft International 
Edition 
Toutes les règles concernant la disposition des éléments, les sauts de pages (avec 
les différents niveaux de suites), les pages A et B, les scènes, etc., ont été 
développées au cours d’un siècle de production de films à Hollywood.  Final Draft a 
été con�u pour respecter ces règles car la bonne présentation d’un scénario est 
souvent significative de son contenu. À Hollywood, l’uniformité d’aspect est très 
importante. 
 
Pourquoi utiliser par défaut la police Courier Final Draft ? 
Par habitude, on considère qu’une minute sur la page correspond à une minute à 
l’écran. Cette convention date de l’époque où les scripts étaient rédigés sur machine 
à écrire. Aussi la plupart des professionnels d’Hollywood souhaitent-ils lire des 
scénarios rédigés exclusivement en police Courier, la plus proche sur le plan 
graphique du style de la machine à écrire. Libre à vous d’utiliser une autre police, 
mais cela n’est pas sans risque. De nombreux professionnels d’Hollywood se 
méfient des scripts qui arborent une police autre que Courier. Ils ont le sentiment 
que vous î trichez î sur la longueur de votre script ou, pire encore, que vous n’êtes 
pas professionnel.  
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REMARQUE :  En raison de cette convention, Final Draft utilise par défaut la 
police Courier Final Draft en 12 points. Cette police de type Courier a été 
spécialement con�ue pour Final Draft. Espacée idéalement pour les scénarios, elle 
est mieux adaptée et plus épaisse que les polices Courier ou Courier New standard. 
Autre avantage, elle permet d’obtenir des pages à l’aspect et au décompte 
identiques sur les ordinateurs Windows et Macintosh.   
 

AVERTISSEMENT :  Final Draft est un traitement de texte puissant et moderne 
capable d’utiliser toutes les polices de votre ordinateur. Toutefois, ses fonctions de 
mise en forme et de pagination des scripts étant toutes basées sur la police Courier 
Final Draft, l’emploi d’une autre police peut empêcher le fonctionnement optimal de 
certaines options. 
Lecture vocale (anglais uniquement) 
Cette fonctionnalité permet de faire lire un script par plusieurs personnages (avec 
des voix différentes). Elle s’appuie sur les moteurs de lecture vocale en anglais 
intégrés aux systèmes d’exploitation Windows et Mac OS. Elle ne fonctionne pas 
avec les autres langues. 
 
Travail de groupe 
Final Draft permet aux utilisateurs de Windows et Mac OS de partager des scripts en 
toute simplicité. Pour travailler avec des personnes non équipées de Final Draft, 
enregistrez votre script au format RTF. Utilisez la commande File > Save As > Rich 
Text Format. Ainsi, toute personne qui dispose de Microsoft Word ou d’un autre 
traitement de texte peut ouvrir et modifier votre script.  
 
Avant de vous renvoyer le script modifié, cette personne doit à son tour l’enregistrer 
au format RTF. Utilisez la commande File > Open pour importer des scripts au 
format RTF. 
 

  AVERTISSEMENT :  Les numéros de scènes ne sont pas enregistrés au format 
RTF. 



FINAL DRAFT INTERNATIONAL EDITION 
 

25 – Premiers pas 
 
 
 

 

 
Didacticiel de script 
Final Draft propose un exemple de script (Out4Life) avec lequel il est possible de 
vous exercer. Il fait partie du didacticiel de ce manuel et de la version complète du 
Final Draft User Guide (en anglais uniquement) fournie au format PDF. N’hésitez pas 
à le remplacer par un bref script de votre choix rédigé dans votre langue. 
 
Utilisation des vérificateurs d’orthographe et des thésaurus 
pour les autres langues 
Au moment de l’installation, deux ensembles vérificateur d’orthographe/thésaurus 
sont installés : l’un en anglais américain et l’autre dans la langue de votre choix. Il 
n’est pas possible d’utiliser simultanément plusieurs langues de vérificateur 
d’orthographe ou de thésaurus. Une fois que vous avez paramétré la langue du 
logiciel, elle reste utilisée par défaut pour tous vos travaux ultérieurs jusqu’à ce que 
vous la modifiiez. 
 
Pour définir le vérificateur d’orthographe de la langue supplémentaire précédemment 
installée : 
1 (Windows) Cliquez sur Tools > Options. 
 
 (Mac OS) Cliquez sur Tools > Spelling. 
 
2   Cliquez sur l’onglet Spelling (Windows) ou Options (Mac OS). La 

bo”te de dialogue apparaît avec le paramètre de langue English (United States) 
sélectionné : 

LISTE CONTEXTUELLE DES
LANGUES

 
 
3     Cliquez dans la liste contextuelle des langues pour 

afficher les autres langues disponibles 
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:

LANGUESSUPPLÉMENTAIRES

 
4     Sélectionnez la langue de votre choix. La bo”te de 

dialogue indique 
:

LA LANGUE A CHANGÉ

 
5 Cliquez sur le bouton Close pour retourner au script dont vous venez de changer 

la langue du vérificateur d’orthographe. 
 

REMARQUE IMPORTANTE : Si le vérificateur d’orthographe est défini pour une 
langue et que vous affichez un script dans une autre langue, presque tous les mots 
sont indiqués comme mal orthographiés, par exemple : 

PRESQUETOUSLES MOTS
SONTINDIQUÉSCOMME

MAL ORTHOGRAPHIÉS

 
Pour corriger ce phénomène : 
Retournez dans la bo”te de dialogue Options ou Spelling et sélectionnez la langue 
appropriée. 
Pour définir le thésaurus de la langue supplémentaire précédemment installée : 
1 Cliquez sur Tools > Thesaurus. 
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2 Cliquez dans la liste contextuelle des langues : 

DANS LA LISTE, SÉLECTIONNEZ
LA LANGUEDEVOTRECHOIX

 
3 Sélectionnez la langue de votre choix. Cliquez sur le bouton Close pour retourner 

au script dont vous venez de changer la langue du thésaurus. 
 
ƒléments 
Les scripts sont composés de différents types d’informations réparties en 
paragraphes : titres de scènes, personnages, dialogues, transitions, etc. Les 
conventions de rédaction de scénarios stipulent que chaque paragraphe doit faire 
l’objet de paramètres spécifiques en matière de retrait, d’alignement, d’espacement, 
de casse, etc. Dans Final Draft, ces paragraphes uniques sont appelés î éléments î. 
Les spécifications de tous les éléments sont définies dans la bo”te de dialogue 
Format > Elements. D’autres logiciels de traitement de texte peuvent s’y référer 
comme à des î styles î ou des î feuilles de style î. 
 
Lorsque vous ajoutez un paragraphe dans un script, les paramètres de la bo”te de 
dialogue Elements s’y appliquent automatiquement, ce qui donne au script un aspect 
cohérent et professionnel. 
 
L’ensemble du script peut être modifié en changeant les paramètres de ses 
éléments. Par exemple, si vous modifiez les retraits de l’élément Dialogue, chaque 
paragraphe de dialogue est remis en forme en conséquence. La longueur du script 
est ajustée en fonction des critères que vous avez redéfinis (ici, il est rallongé ou 
raccourci). La plupart des scripts peuvent être rédigés en utilisant seulement les jeux 
d’éléments par défaut. Les éléments peuvent aussi être modifiés et développés, ce 
qui permet de personnaliser complètement l’aspect de vos scripts.  
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Pour modifier les éléments :  
1 Cliquez sur Format > Elements pour faire apparaître la bo”te de dialogue 

Elements : 

LISTEDES
ÉLÉMENTS

 
La bo”te de dialogue Elements permet de définir tous les aspects de chaque 
élément. Elle contient la liste des éléments actuels, ainsi que l’ensemble de leurs 
paramètres de touches, de marges, d’alignement, d’espacement et de style.  
 
2 Modifiez chaque élément à votre convenance. 
 
3 Cliquez sur OK. 
 
Onglet Basic 
La liste des éléments contient les paragraphes définis pour le script actuellement 
ouvert. Les caractéristiques d’un élément (Scene Heading dans l’illustration ci-
dessus) sont définies par les options sélectionnées dans les onglets Basic, Font et 
Paragraph de la bo”te de dialogue Elements. 
 
Zone Behavior 
Les options de la zone Behavior déterminent le comportement du logiciel lorsqu’un 
élément est ajouté ou inséré dans un script. 
 

Case à cocher Start new page 
Lorsque cette case à cocher est activée, une nouvelle page est créée à l’endroit 
où vous ajoutez ou insérez un élément. Par défaut, ce paramètre est désactivé, 
car il n’existe pas d’élément de script î conventionnel î qui génère 
automatiquement une nouvelle page. 
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Liste contextuelle Paginate as 
Cette option définit la manière dont Final Draft effectue les sauts de pages 
lorsque le texte s’étend sur plusieurs pages. Elle est désactivée pour les éléments 
par défaut et activée uniquement pour les éléments personnalisés. Vous pouvez 
utiliser les règles de saut de page affectées à l’un des éléments par défaut ou ne 
définir aucune règle particulière (None). 
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Par exemple, supposons que vous écriviez une comédie musicale et que vous 
ayez créé un élément spécial intitulé Lyrics à utiliser lorsque les personnages 
chantent. Si vous donnez à l’élément Lyrics la même mise en page que l’élément 
Dialogue, il ne sera pas séparé du paragraphe Character qui lui est associé. 
 

Zone Shortcuts 
Les options de la zone Shortcuts déterminent quels raccourcis sont utilisés pour 
ajouter ou insérer des éléments. Elles indiquent également quel élément est 
automatiquement créé lorsque vous appuyez sur la touche Entrée (Windows) ou 
Retour (Mac OS) après la saisie de texte. 
 
Pour créer un élément personnalisé : 
1 Cliquez sur le bouton New. 
 
Un nom par défaut apparaît dans la liste des éléments et dans le champ de texte 
situé juste audessus. 
 
2 Dans le champ de texte, renommez le nouvel élément à votre convenance. Le 

nom dans la liste des éléments est modifié automatiquement. 
 
Les options des onglets Basic, Font et Paragraph reprennent par défaut celles de 
l’élément General. 
 
3 Effectuez les modifications de votre choix. 
 
Pour supprimer un élément personnalisé : 
1 Sélectionnez un élément personnalisé. Le bouton Delete est activé. 
 
2 Cliquez sur Delete.  
 
Pour charger des éléments à partir d’autres scripts ou de fichiers de modèle : 
1 Cliquez sur le bouton Apply a Template pour faire apparaître la bo”te de dialogue 

: 
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2 La liste des fichiers disponibles dans le dossier Stationery apparaît.  
– ou – 
 Cliquez sur Browse et recherchez l’emplacement de stockage des scripts ou des 

fichiers de modèle. 
 
3 Sélectionnez le fichier de votre choix. 
 
Les éléments du fichier sont chargés et vous pouvez les modifier pour les utiliser 
avec votre script. 
 
Onglet Font 
Cet onglet indique les paramètres de police et de taille utilisés pour chaque élément. 
Par défaut, la police utilisée est Courier Final Draft 12. 
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AVERTISSEMENT :  L’usage de la police Courier (taille 12 points, style texte brut), 
qui représente un héritage des î temps anciens î, constitue la norme officielle de 
l’aspect des scripts. Ces paramètres de police et de taille par défaut correspondent 
aux caractéristiques de la plupart des machines à écrire d’antan. Libre à vous 
d’utiliser une autre police, mais cela n’est pas sans risque. De nombreux 
professionnels d’Hollywood se méfient des scripts qui arborent une police autre que 
Courier. Ils ont le sentiment que vous î trichez î sur la longueur de votre script ou, 
pire encore, que vous n’êtes pas professionnel. 
 
Pour définir la police et la taille d’un élément : 
1 Dans la liste, cliquez sur l’élément de votre choix. 
 
2  Cliquez sur l’onglet Font. 
 
3 Cliquez sur Set Font. 
La bo”te de dialogue Font de votre système d’exploitation apparaît. 
 
4 Effectuez les modifications de votre choix et cliquez sur OK. 
 
Pour définir la police et la taille de tous les éléments : 
1 Modifiez les attributs de police d’un élément. 
 
2 Cliquez sur Apply Font/Size to All Elements. 
Tous les éléments sont alors définis avec les mêmes paramètres de police et de 
taille. 
 
Onglet Paragraph 
Les options de cet onglet déterminent des attributs supplémentaires pour chaque 
élément. 
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Liste contextuelle Align 
Cette liste présente les options d’alignement Left, Centered, Right et Justified. 
L’option par défaut est Left. 
 
Liste contextuelle Spacing 
Cette liste présente les options 1, 1.5, 2 et 3. L’option par défaut est 1. 
 
Liste contextuelle Space before 
Cette liste permet de modifier l’espacement avant le paragraphe contenant le 
point d’insertion ou pour chaque élément d’une sélection. Les options disponibles 
sont 0, 1, 2 et Other (où vous pouvez saisir une valeur jusqu’à 30).  
 
Zone Indents : options Left et Right 
Mesurés en pouces à partir du bord gauche de la page, ces paramètres 
définissent le retrait de chaque élément. 

 
Pour modifier les paramètres de retrait à gauche ou à droite d’un élément : 
1 Dans la liste, cliquez sur l’élément de votre choix. 
 
2  Cliquez sur la flèche vers le haut ou le bas en regard du paramètre choisi. 
 
Pour plus d’informations sur la gestion des éléments, consultez la section Elements 
dans la version complète du manuel Final Draft User Guide (en anglais uniquement) 
qui est installée au format PDF sur votre ordinateur. 
 
Bo”te de dialogue Page Layout 
Cette bo”te de dialogue contient les options qui définissent l’affichage sur l’écran et 
sur papier. 
 
Onglet Margins 
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Cliquez sur Document > Page Layout pour faire apparaître la bo”te de dialogue : 

 
 
Zone Text margins : options Top et Bottom 
Mesurés en pouces à partir du haut et du bas de la page, ces paramètres définissent 
l’espace vierge laissé dans les marges supérieure et inférieure de chaque page. En 
jouant sur l’espace vierge en haut et en bas de la page, vous pouvez modifier la 
longueur de votre script. Les paramètres par défaut sont Top = 1.00 et Bottom = 
1.00. 
 
Zone Header/Footer margins 
Mesurés en pouces à partir du haut et du bas de la page, ces paramètres définissent 
l’espace vierge laissé au-dessus de l’en-tête et au-dessous du pied de page. Le 
paramètre par défaut est 0.50 dans les deux cas. 
Pour modifier les paramètres de marge : 
1 Cliquez sur la flèche vers le haut ou le bas en regard du paramètre choisi. 
 
2 Cliquez sur OK pour appliquer les nouveaux paramètres à l’ensemble du script. 
 
Onglet Colors 
Dans la bo”te de dialogue Page Layout, cliquez sur l’onglet Colors pour faire 
apparaître le panneau : 

 
Les paramètres par défaut sont Background = blanc, Text = noir et Invisibles = gris. 
Pour modifier les options de couleur : 
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1 Cliquez sur l’échantillon de couleur approprié.  
 
(Windows) La palette de couleurs standard apparaît. Sélectionnez une couleur ou 
cliquez sur Other pour afficher la bo”te de sélection des couleurs standard.  
(Mac OS) La bo”te de sélection des couleurs standard apparaît.  
2 Sélectionnez la couleur de votre choix et cliquez sur OK.  
 
La nouvelle couleur s’affiche à la place d’un échantillon de couleur existant. 
 
Onglet Options 
Dans la bo”te de dialogue Page Layout, cliquez sur l’onglet Options pour faire 
apparaître le panneau : 

 
Liste contextuelle Line spacing : options Very Tight, Tight, Normal et Loose  
Cette option définit l’écartement des lignes entre elles sur la page. Les typographes 
et les graphistes appellent ce paramètre l’î interligne î. ƒvidemment, la longueur du 
script varie en fonction de l’espacement sélectionné. Le paramètre par défaut est 
Normal.  
Par exemple, un script de 100 pages avec un interligne défini sur Normal correspond 
à : 
 
Environ 88 pages avec l’interligne défini sur Very Tight. 
Environ 94 pages avec l’interligne défini sur Tight.  
Environ 109 pages avec l’interligne défini sur Loose. 
 
Option Enable smart quotes 
Cette option détermine le comportement de Final Draft lorsque vous appuyez sur la 
touche î ou '. Il peut ainsi remplacer ces caractères par le guillemet spécial orienté à 
gauche ou à droite selon la situation. Par défaut, cette option est désactivée. 
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Option Break dialogue and action at sentences 
Cette option empêche Final Draft de couper les phrases des paragraphes Dialogue 
et Action avec un saut de page lorsque cela s’avère possible. Par défaut, cette 
option est activée. 
 
Option Automatic cast list generation 
La liste des interprètes est utilisée dans les sitcoms pour préciser les personnages 
qui apparaissent dans une scène. Ces informations sont normalement placées 
directement sous le titre de la scène. Par exemple : 

LISTE DES
INTERPRÈTES

 
Pour générer une liste des interprètes dans chaque scène : 
1 Créez un élément contenant la liste des interprètes : 

- Cliquez sur Format > Elements. 
- Cliquez sur New. Saisissez le nom de cet élément, de préférence Cast List 
         . 
- Définissez le paramètre Enter key de la zone Shortcut sur Action. 

 
2 (Facultatif) Modifiez le raccourci Enter key de l’élément Scene Heading. 

- Sélectionnez Scene Heading dans la liste des éléments. 
- Définissez le paramètre Enter key de la zone Shortcut sur l’élément que vous 
venez de créer. 
- Cliquez sur OK. 

 
3 Paramétrez Final Draft pour qu’il crée automatiquement une liste des interprètes. 

- Cliquez sur Document > Page Layout > Options. 
- Dans la liste contextuelle Cast list element, cliquez sur l’élément que vous 

venez de créer.  
 

REMARQUE :  Si vous avez nommé le nouvel élément î Cast List î, celui-ci est 
automatiquement sélectionné dans le champ Cast list element. 

- Cliquez sur OK. 
 
4 Saisissez un titre de scène dans le script. 
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5 Appuyez sur Entrée (si vous avez modifié le raccourci de l’élément Scene 
Heading) 

– ou – 
 Appuyez deux fois sur Entrée (si vous n’avez pas modifié le raccourci de 

l’élément Scene Heading) et sélectionnez Cast List dans la liste Elements. 
 
6 Appuyez sur Entrée ou sur d’autres raccourcis pour continuer la rédaction du 

script. 
 
À mesure que les personnages entrent en scène, leur nom est automatiquement 
ajouté dans l’élément personnalisé Cast List. Lorsqu’un personnage quitte une 
scène, son nom est retiré de la liste des interprètes correspondante. 
 
Enregistrement de fichiers PDF 
Vous pouvez indiquer à Final Draft s’il doit inclure ou exclure la page de titre au 
début d’un script enregistré au format PDF lorsque vous cliquez sur File > Save As 
PDF. Par défaut, cette option est activée. 
 
Lorsque vous avez terminé : 
Cliquez sur OK. 
Pour plus d’informations sur la mise en forme des pages, consultez la section 
Documents Menu dans la version complète du manuel Final Draft User Guide (en 
anglais uniquement) qui est installée au format PDF sur votre ordinateur. 
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Bo”te de dialogue Mores and Continueds 
Les conventions hollywoodiennes de rédaction de scripts comportent des règles 
spécifiques sur l’agencement des dialogues et des scènes en cas de saut de page. 
Final Draft gère ces règles automatiquement et ajuste le texte à mesure que vous 
progressez dans votre travail. En outre, vous pouvez modifier le mode d’application 
de ces règles et utiliser les mots que vous souhaitez dans votre langue. 
 
Réplique coupée par un saut de page 
Lorsqu’une réplique s’étend sur plusieurs pages, l’acteur doit être averti à chaque 
fois qu’il doit passer à la page suivante. Le dialogue est interrompu à la fin d’une 
phrase (si possible), le mot (MORE) est inséré au centre sous le paragraphe de 
dialogue, le nom du personnage est répété sur la page suivante et le mot (cont’d) – 
pour î continued î – est inséré avant la reprise de la réplique. Par exemple : 

SAUTDEPAGE

DÉBUTDELA RÉPLIQUE

PARAGRAPHECOUPÉÀ LA FIN
D’UNEPHRASELEMOT(MORE) EST

AUTOMATIQUEMENTINSÉRÉ

LENOM DU PERSONNAGE
ESTRÉPÉTÉ

AUTOMATIQUEMENT

LEMOT(CONT’D) EST
AUTOMATIQUEMENTINSÉRÉ

 
Par défaut, Final Draft effectue ces opérations automatiquement. 
 
Scène coupée par un saut de page 
Lorsqu’une scène est coupée par un saut de page, le mot (CONTINUED) apparaît 
dans le coin inférieur droit de la première page et le mot CONTINUED: apparaît dans 
le coin supérieur gauche de la seconde page à c™té du numéro de scène (qui est 
identique à celui de la première page). Il s’agit d’une fonctionnalité optionnelle qui 
n’est pas intégrée par défaut au modèle de scénario standard. 
 

REMARQUE :  Si aucune scène n’est numérotée, l’emploi de cette fonction peut 
créer des confusions, car la plupart des scènes se poursuivent sur les pages 
suivantes. 
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SAUTDEPAGE

DÉBUTDELA SCÈNE

LEMOTCONTINUED:
ESTAJOUTÉ

AUTOMATIQUEMENT

LEMOT
(CONTINUED) EST
AJOUTÉ
AUTOMATIQUEMENT

 
 
Scène se poursuivant sur plusieurs pages 
Lorsqu’une scène se poursuit sur plusieurs pages et qu’elle est coupée par des 
sauts de page, le mot (CONTINUED) apparaît dans le coin inférieur droit de la 
première page et le mot CONTINUED:  (#) apparaît dans le coin supérieur gauche 
de la deuxième page, à c™té du numéro de scène (qui est identique à celui de la 
première page). Le numéro représente le nombre de pages total de la scène. Il s’agit 
d’une fonctionnalité optionnelle qui n’est pas intégrée par défaut au modèle de 
scénario standard. 

SAUTDEPAGE

LEMOTCONTINUED:
(2) ESTAJOUTÉ

AUTOMATIQUEMENT

LEMOT
(CONTINUED) EST
AJOUTÉ
AUTOMATIQUEMENT

 
 
Utilisation des suites 
Cliquez sur Documents > More and Continueds pour faire apparaître la bo”te de 
dialogue More and Continueds. Elle détermine le texte et les options d’insertion des 
suites dans les dialogues et les scènes.  
 
Vous pouvez l’utiliser pour activer ou désactiver ces fonctionnalités, mais aussi pour 
modifier le texte automatiquement inséré par Final Draft, et ce dans la langue de 
votre choix. 
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SAUTS DEDIALOGUE

SAUTSDESCÈNE

 
Zone Dialogue breaks 
Final Draft tente de ne pas couper les dialogues lorsqu’il change de page. Pourtant, 
dans certains cas, il n’est pas possible de faire autrement. Le texte défini dans 
l’option Bottom of page (MORE) est alors inséré juste au-dessous du dialogue, au 
bas de la première page. En haut de la page suivante, le nom du personnage est 
répété et le texte défini dans l’option Top of next page (cont’d) est inséré. 
Si l’une des cases à cocher Bottom of page ou Top of next page est désactivée, le 
texte correspondant n’apparaît ni à l’écran ni sur papier. Par défaut, les deux cases à 
cocher sont activées. 
 
 

Option Automatic Character Continueds 
Cette option permet d’insérer automatiquement le mot î (cont’d) î après le nom 
d’un personnage s’il parle plusieurs fois pendant une scène. Elle est utilisée pour 
avertir le lecteur que le même personnage poursuit sa réplique après avoir été 
interrompu par l’action. Par défaut, cette option est activée. 
 
Le mot î (cont’d) î est ajouté uniquement si aucun autre personnage ne vient 
interrompre la réplique de l’interprète. Le mot î (cont’d) î n’est jamais inséré si les 
répliques interviennent dans des scènes différentes. 

 
Zone Scene breaks 
Lorsqu’une scène se poursuit d’une page à l’autre, Final Draft insère le texte défini 
dans l’option Bottom of page (CONTINUED) au bas de la première page et le texte 
défini dans l’option Top of next page (CONTINUED:) en haut de la page suivante, à 
c™té du numéro de la scène interrompue par le saut de page.  
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Si l’une des cases à cocher Bottom of page ou Top of next page est désactivée, le 
texte correspondant n’apparaît ni à l’écran ni sur papier. Par défaut, les deux cases à 
cocher sont désactivées. 

Case à cocher CONTINUED: (#) 
Cette option ajoute un numéro après le texte CONTINUED (ex. : (2), (3), etc.) en 
haut de chaque suite de page pour indiquer le nombre de pages de la scène. Par 
défaut, cette option est désactivée. 

 
Pour modifier le texte d’une option de la bo”te de dialogue More and Continueds : 
Changez le contenu du champ de texte approprié. 
 
Zone Font 
Cette zone indique la police et la taille du texte défini dans les options de la bo”te de 
dialogue More and Continueds, tel qu’il apparaît à l’écran ou sur papier. Par défaut, 
la police utilisée est Courier Final Draft 12. 
 
Pour définir les attributs de police : 
1 Cliquez sur Set Font. 
 
La bo”te de dialogue Font de votre système d’exploitation apparaît. 
 
2 Effectuez les modifications de votre choix et cliquez sur OK. 
 
Lorsque vous avez terminé : 
Cliquez sur OK pour appliquer les modifications au script. 
 
Pour plus d’informations sur l’insertion de suites via la bo”te de dialogue Mores and 
Continueds, consultez la section Documents Menu dans la version complète du 
manuel Final Draft User Guide (en anglais uniquement) qui est installée au format 
PDF sur votre ordinateur. 
 
Macros 
Les macros sont des combinaisons de touches utilisées pour saisir du texte. Final 
Draft compte vingt macros qui permettent de saisir les termes les plus récurrents 
pendant la rédaction des scripts en anglais (INT., EXT., - DAY, CUT TO:, etc.). 
Lorsque vous appuyez sur la combinaison de touches d’une macro, le texte 
correspondant est inséré dans le script comme si vous l’aviez saisi manuellement. 
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Les macros permettent également de créer des paragraphes spécifiques avant et 
après la saisie de texte.  
 
Vous pouvez modifier les combinaisons de touches et le comportement des macros. 
Final Draft pour Windows et Final Draft pour Macintosh offrent des versions 
légèrement différentes de la fonctionnalité Macros, avec quelques variantes dans les 
fonctions. 
 
Comme avec les options de la bo”te de dialogue More and Continueds, vous pouvez 
utiliser les termes que vous souhaitez dans votre langue. 
 
 
 
Pour afficher ou modifier les paramètres des macros : 
Cliquez sur Document > Macros pour faire apparaître la boite de dialogue 
:

WINDOWS MAC OS

 
 
Pour modifier une macro : 
1 Sélectionnez la macro dans la liste. 
 
2 Renommez-la dans la zone de texte Name en utilisant une abréviation aussi 

courte que possible.  
 
3 Cliquez dans la zone de texte Macro text et saisissez le texte à insérer lorsque la 

macro est activée. 
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Pour plus d’informations sur la gestion des macros, consultez la section Documents 
Menu dans la version complète du manuel Final Draft User Guide (en anglais 
uniquement) qui est installée au format PDF sur votre ordinateur. 
 
Modèles 
Le format Final Draft Template (.fdt) permet d’enregistrer le modèle d’un script ou 
d’un document texte. Un modèle comporte tous les attributs du script correspondant, 
y compris le texte qu’il contient. Il enregistre les paramètres des fonctionnalités 
Elements, Page Layout, Header and Footer, Mores and Continueds, Title Page, 
SmartType et Macros dans un fichier unique. Par exemple, vous pouvez créer un 
modèle contenant des attributs de script spécifiques pour l’envoyer par courrier 
électronique à une équipe d’auteurs. 
 

REMARQUE :  Le choix des vérificateurs d’orthographe et des thésaurus pour les 
langues supplémentaires est une préférence du programme qui n’est pas 
enregistrée dans le modèle.  
 



FINAL DRAFT INTERNATIONAL EDITION 
 
44 – Premiers pas 
 
 

 

Pour enregistrer des attributs de script dans un modèle : 
1 Modifiez à votre convenance les paramètres des bo”tes de dialogue Elements, 

Page Layout, etc. 
2 Cliquez sur File > Save As. 
 
3 Pour ajouter le modèle dans le répertoire contenant les autres modèles de Final 

Draft, recherchez le dossier   Final Draft 7 > Stationery 
 – ou –  
 Sélectionnez un autre emplacement. 
 
4 Dans la liste contextuelle Save as type, sélectionnez Final Draft Template 

:

 
5 Renommez le modèle. 
 
6 Cliquez sur Enregistrer. 
 
Le modèle est désormais créé. Vous pouvez l’utiliser à tout moment. 
 
Final Draft comprend en standard un certain nombre de modèles. Consultez la 
section File Menu dans la version complète du manuel Final Draft User Guide (en 
anglais uniquement) qui est installée au format PDF sur votre ordinateur. 
 
Utilisation du papier A4 
Par défaut, Final Draft utilise les pilotes d’impression installés sur votre système 
d’exploitation. Si les paramètres de votre imprimante sont définis pour le papier A4, 
les pages de Final Draft seront imprimées dans ce format. Ce paramètre peut être 
modifié manuellement si nécessaire. 
 
Pour définir le format de papier : 
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(Windows) Cliquez sur Démarrer > Paramètres > Imprimantes > Propriétés. 
Sélectionnez un format de papier et cliquez sur OK.   
 
(Mac OS) Cliquez sur Fichier > Mise en page. Sélectionnez un format de papier et 
cliquez sur OK. 
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Didacticiels 
Introduction 
Final Draft est un traitement de texte riche en fonctionnalités, spécialement con�u 
pour l’écriture de scénarios de cinéma, de télévision et de théâtre. Il associe de 
puissantes fonctions de traitement de texte à des capacités intelligentes de mise en 
forme des scénarios. L’auteur peut ainsi se concentrer sur son œuvre en pensant au 
fond plut™t qu’à la forme. Si vous avez déjà utilisé un traitement de texte standard, 
la plupart des fonctions d’édition (sélection de texte, changement des polices, 
alignement, etc.) vous sembleront familières. Final Draft permet également de 
rédiger des documents î classiques î, par exemple des synopsis, des lettres, des 
résumés, etc. Il comporte plusieurs dizaines de modèles, adaptés notamment à la 
mise en forme de scénarios standard pour le cinéma ou le théâtre, ainsi que les 
formats de la plupart des succès télévisés d’aujourd’hui. De quoi accélérer 
considérablement le processus d’apprentissage. 
 
Pour faciliter autant que possible la saisie de texte, les touches Tab et Entrée sous 
Windows et Tab et Retour sous Mac OS permettent d’effectuer la majorité des 
fonctions de mise en forme spécifiques de la rédaction de scripts. Elles sont 
complétées par un certain nombre de raccourcis d’éléments et de macros. Une fois 
que vous savez utiliser ces commandes clé, vous disposez de tous les outils 
nécessaires pour rédiger de manière rapide et intuitive un script au format adapté. 
Exactement ce qu’attend de vous l’industrie du divertissement. 
 
Ce didacticiel vous guide à travers les étapes de création d’un script et de saisie des 
premières lignes de texte. Ensuite, il vous apprend à utiliser un certain nombre de 
fonctionnalités très utiles pour la rédaction d’un script. Il présente également une 
partie des nombreuses fonctions, dont certaines exclusives, qui font de Final Draft le 
choix numéro un des scénaristes du monde entier.  
 
Plusieurs méthodes sont disponibles pour exécuter la plupart des fonctions de Final 
Draft. Vous pouvez ainsi choisir celle qui convient le mieux à votre style d’écriture. 
  
Pour apprendre, rien ne remplace la pratique. Vous conna”trez mieux et plus 
rapidement Final Draft si vous faites les exercices proposés par ces didacticiels. Ils 
vous aideront à créer votre premier script et à vous exercer avec les exemples de 
scripts et de synopsis fournis. 
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Démarrage de Final Draft 
 
Windows 
1 Cliquez sur le bouton Démarrer. 
 
2 Dans le menu Démarrer, cliquez sur Programmes ou (Windows XP) Tous les 

programmes. 
 
3 Dans le sous-menu Programmes, cliquez sur Final Draft 7. 
 
Macintosh 
1 Ouvrez le dossier Final Draft 7. 
 
2 Ouvrez (lancez) Final Draft 7. 
 

REMARQUE IMPORTANTE :  Pour utiliser Final Draft sans restrictions, activez votre 
ordinateur. Consultez la section Premier lancement (Démarrage) de Final Draft 7 
précédemment dans ce manuel. 
 
Une fenêtre de script vierge apparaît, dans laquelle vous pouvez commencer la 
saisie. 
 

REMARQUE :  À ce stade, si vous cliquez sur File > Open pour ouvrir un document 
existant, le document vierge sans titre se ferme automatiquement. 
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WINDOWS XP

LISTEDES ÉLÉMENTS
BARRED’OUTILS

RÈGLE

POINTD’INSERTION

BARRED’ÉTAT

NUMÉRO DEPAGE
NUMÉRO DESCÈNE

LIBELLÉDEL’ÉLÉMENT

MAC OS

LISTEDES ÉLÉMENTS
BARRED’OUTILS

RÈGLE

POINTD’INSERTION

BARRED’ÉTAT

NUMÉRO DE
NUMÉRO DEPAGE

LIBELLÉ DEL’ÉLÉMENT
NUMÉRO DESCÈNE
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Le point d’insertion clignotant indique l’emplacement du prochain caractère saisi.  
 
Dans Final Draft, les éléments représentent les différents types de paragraphes d’un 
script, chacun d’eux possédant ses propres paramètres de marge, d’alignement et 
de casse. La barre d’outils (en haut de la fenêtre) comprend une liste des 
éléments. Au bas de la fenêtre figure également une zone contenant le libellé de 
l’élément. Ces deux indicateurs permettent de savoir dans quel élément se trouve le 
point d’insertion.  
 
Par défaut, le libellé de l’élément et la liste des éléments indiquent Scene Heading 
en début de script. En effet, Final Draft commence chaque script par un titre de 
scène. Toutes les scènes d’un script débutent par un titre, ce qui permet au lecteur de 
situer l’action dans l’espace et le temps. 
 
La barre d’état indique quel élément sera créé ou quelle opération sera déclenchée 
si vous appuyez sur une touche ou une combinaison de touches spécifique. 
 
Voici un extrait de script contenant la plupart des éléments de base d’un script 
(hormis Shot) 
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:

EXT. STUDIO PARKING LOT - DAY

A WRITER and an AGENT are walking from the parking
lot towards an office.

AGENT
(whispers)

Just follow my lead. I know
you’re ready to do this pitch.

     DISSOLVE TO:

EXT. STUDIO PARKING LOT - DAY

NARRATOR (V.O.)
The Grand Canyon is one of the jewels
of our National Park System.

Pour obtenir des informations plus détaillées sur les éléments, consultez la section Éléments.

TITREDE
SCÈNE

ACTION

PERSONNAGE
PARENTHÈSES
DIALOGUE

TRANSITION

INTRO SCÈNE
EMPLACEMENT
HEURE

EXTENSION PERS.
PERSONNAGE

Un titre de scène est constitué de :

Une extension de personnage est utilisée si nécessaire :

 
Utilisation des touches Tab et Entrée  
Vous pouvez changer automatiquement de paragraphe en utilisant les touches Tab 
et Entrée (Windows) ou Tab et Retour (Mac OS). Cela vous permet de saisir du texte 
sans vous soucier de sa mise en forme. Doué d’intelligence, Final Draft donne à 
chaque élément de script le format approprié. Il sait exactement comment les 
espacer sur la page. 
 

REMARQUE :  Dans la section qui suit, les touches Entrée (Windows) et Retour 
(Mac OS) sont représentées par l’expression î Entrée/Retour î. 
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En règle générale : 
 

  Appuyez sur la touche Tab (tabulation) pour passer à l’élément logique 
suivant (î à droite î). 

 
 Appuyez sur la touche Entrée/Retour pour créer l’élément qui suit 
î habituellement î celui dans lequel vous vous trouvez. 

 
Touche Tab 
La touche Tab déplace le point d’insertion vers la droite. Chaque position de ce 
dernier dans la page de script correspond à un nouvel élément. 
 

 Pour passer à un autre élément depuis un élément vierge : 
 Dans l’élément Scene Heading, appuyez sur la touche Tab pour accéder à 
l’élément Action, à nouveau sur Tab pour accéder à l’élément Character, à 
nouveau sur Tab pour accéder à l’élément Transition et une dernière fois sur Tab 
pour revenir à l’élément Scene Heading. 

 
Si vous ne saisissez pas de texte dans aucun de ces éléments, le programme agit à 
chaque utilisation de la touche Tab comme s’il s’agissait de la touche Entrée/Retour 
(voir ci-après), sauf dans le cas de l’élément Character. Conformément aux normes 
en vigueur, chaque fois que vous saisissez un élément Character, il doit être suivi 
d’un élément Parenthetical ou Dialogue.  
 

Si vous ajoutez un élément Character ou s’il est inséré automatiquement par la 
fonctionnalité Smart Type, appuyez sur la touche Tab pour faire défiler 
uniquement les éléments liés au personnage : 
Ajoutez ou insérez automatiquement un élément Character, puis appuyez sur la 
touche Tab pour afficher l’élément Parenthetical et à nouveau sur Tab pour 
afficher l’élément Dialogue. 

 
 Si vous avez saisi un élément Dialogue : 
Appuyez sur la touche Tab pour afficher l’élément Parenthetical, puis à nouveau 
sur Tab pour revenir à l’élément Dialogue. 

 
Cette opération est effectuée même si vous laissez vides les parenthèses. Si vous 
ne saisissez ni un élément Parenthetical, ni un élément Dialogue, appuyez sur la 
touche Tab pour passer de l’un à l’autre jusqu’à ce que vous ajoutiez du texte dans 
l’un d’eux ou jusqu’à ce que vous appuyiez sur la touche Entrée/Retour. 
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 CONSEIL :  Appuyez sur Maj + Tab pour faire défiler les éléments dans l’ordre 
inverse. 
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Touche Entrée/Retour 
En tant qu’auteur, la touche Entrée/Retour vous sert normalement à marquer la fin 
d’un paragraphe, ce qui est également valable dans Final Draft. La touche 
Entrée/Retour est utilisée lorsque vous avez terminé un paragraphe pour passer à 
l’élément qui le suit généralement : 
 

Saisissez un élément Scene Heading, puis appuyez sur la touche Entrée/Retour 
pour passer à l’élément Action. 
 
Saisissez un élément Action, puis appuyez sur la touche Entrée/Retour pour 
passer à un autre élément Action. 
 
Saisissez un élément Character Name, puis appuyez sur la touche 
Entrée/Retour pour passer à l’élément Dialogue. 
 
Saisissez un élément Parenthetical, puis appuyez sur la touche Entrée/Retour 
pour passer à l’élément Dialogue. 
 
Saisissez un élément Dialogue, puis appuyez sur la touche Entrée/Retour pour 
passer à l’élément Action. 
 
Saisissez un élément Transition, puis appuyez sur la touche Entrée/Retour pour 
passer à l’élément Scene Heading. 

 

REMARQUE :  Lorsque vous avez saisi un élément Action, la touche 

Entrée/Retour  ne permet pas de passer à un autre type d’élément. En effet, un 
élément Action peut être suivi d’un autre élément Action, d’un élément Character 
Name, d’un élément Transition ou d’un élément Scene Heading. Il n’existe pas 
d’élément î type î employé au sortir d’un élément Action. 
 
Lorsque vous êtes dans un élément vierge, appuyez sur Entrée/Retour pour afficher 
la liste contextuelle Elements : 
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Vous pouvez ainsi choisir très facilement l’élément de votre choix. 
 
Pour sélectionner un élément de la liste contextuelle Elements : 
 Saisissez la première lettre de l’élément concerné. Elle apparaît entre crochets î [ 

] î dans la bo”te de dialogue. 
– ou – 
 Utilisez les touches de direction Haut et Bas pour vous déplacer dans la liste et 

sélectionner l’élément de votre choix, puis appuyez sur la touche Entrée/Retour 
ou Tab. 

– ou – 
 À l’aide de la souris, cliquez sur l’élément de votre choix.  
 

REMARQUE :  Vous pouvez saisir des extensions de personnages manuellement 
ou via un menu contextuel : 
(Windows) Cliquez avec le bouton droit de la souris. 
(Mac OS) Cliquez avec le bouton droit de la souris (souris à deux boutons). Appuyez 
sur la touche Ctrl + cliquez avec la souris (souris à un seul bouton). 
 

REMARQUE :  La barre d’état vous donne des informations sur ce qui se passe à 
l’écran. Elle indique toujours quel paragraphe sera créé si vous appuyez sur la 
touche Tab ou Entrée/Retour. Par exemple, si vous venez de saisir un élément 
Character, elle indique :  

 
 

REMARQUE :  Sur Macintosh, la barre d’état indique [Enter], mais il s’agit bien de 
la touche Retour. 
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Vous pouvez rédiger des scripts complets et parfaitement mis en forme simplement 
en utilisant les touches Tab et Entrée/Retour.  
 
Dans la section suivante, nous allons commencer à écrire ensemble un bref exemple 
de script. 
 

Saisie d’un exemple de script 
 
Ouvrez Final Draft sur un scénario vierge sans titre :  
1 Saisissez :  I 
 
La lettre est automatiquement mise en majuscules, car les titres de scènes 
contiennent uniquement des majuscules. 
 
La liste SmartType des introductions de scènes apparaît. Le choix INT.(abréviation 
d’î Intérieur î) est sélectionné : 

 
 
Les listes SmartType, qui facilitent la saisie répétitive, seront abordées plus en 
détails ultérieurement.  
 
2 Appuyez sur la touche Tab pour accepter le choix proposé et ajouter 

automatiquement un point et un espace.  
 
Saisissez un élément Location : 
 
3 Saisissez : DARK OFFICE 
4 Appuyez sur la touche Tab.  
 
Un espace, un tiret (î – î) et un autre espace sont ajoutés automatiquement. La liste 
SmartType de l’heure apparaît : 
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5 Saisissez : N 
 
Le mot NIGHT est sélectionné : 

 
 
6 Appuyez sur la touche Entrée/Retour pour accepter le choix proposé. 
 
7 Saisissez :  The office is dark. Hunched over the desk, staring 

intently at a computer, sits a WRITER. Appuyez deux fois sur la 
touche Tab pour passer à l’élément Character. 

 
8 Saisissez :  WRITER, puis appuyez sur la touche Tab. 
 
9 Saisissez :  excited, puis appuyez sur la touche Entrée/Retour. 
 
Comme vous pouvez le constater, lorsque vous êtes dans un élément Parenthetical 
Final Draft ajoute les parenthèses à votre place.     
       En outre, il n’est pas nécessaire de 
déplacer le point d’insertion ou de saisir du texte hors des parenthèses pour appuyer 
sur la touche Entrée/Retour en vue de passer à l’élément Dialogue. 
 
10 Saisissez :  I sure hope my bid for that old manuscript on eBay 

was accepted! 
 
À mesure que vous avez saisi le texte, Final Draft l’a automatiquement mis en forme 
en utilisant le format de script approprié. Sur l’écran, votre page doit ressembler à 
ceci : 
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INDIQUEUN MOTMAL ORTHOGRAPHIÉ
OU INCONNU  

 

REMARQUE :  Le texte saisi apparaît en police Courier Final Draft 12 points. 
Cette police de type Courier a été spécialement con�ue pour Final Draft. Espacée 
idéalement pour les scénarios, elle est mieux adaptée et plus épaisse que les 
polices Courier ou Courier New standard. Autre avantage, elle présente un aspect 
identique sur les ordinateurs Windows et Macintosh. 
 
 

AVERTISSEMENT :  L’usage de la police Courier (taille 12 points, style texte brut), 
qui représente un héritage des î temps anciens î, constitue la norme officielle de 
l’aspect des scripts. Ces paramètres de police et de taille par défaut correspondent 
aux caractéristiques de la plupart des machines à écrire d’antan. Libre à vous 
d’utiliser une autre police, mais cela n’est pas sans risque. De nombreux 
professionnels se méfient des scripts qui arborent une police autre que Courier. Ils 
ont le sentiment que vous î trichez î sur la longueur de votre script ou, pire encore, 
que vous n’êtes pas professionnel. 
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REMARQUE :  Pendant la saisie, Final Draft signale automatiquement (en les 
soulignant) les mots inconnus ou potentiellement mal orthographiés.  
  
 
Utilisation des raccourcis d’éléments 
Vous pouvez continuer à rédiger un script complet et parfaitement mis en forme en 
utilisant seulement les touches Tab et Entrée/Retour. Toutefois, Final Draft vous 
propose une autre méthode de travail, basée sur les raccourcis d’éléments. Ces 
raccourcis utilisent comme base la touche Contr™le (Ctrl) sous Windows ou 
Commande/Pomme sous Mac OS. Les raccourcis d’éléments permettent 
d’effectuer les mêmes fonctions que les touches Tab et Entrée/Retour et plus 
encore. 
 
Pour activer un raccourci d’élément, appuyez simultanément sur la touche Contr™le 
(Ctrl) sous Windows ou Commande sous Mac OS et sur la touche correspondante. 
Pour afficher les raccourcis d’éléments de Final Draft : 
Maintenez la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée.  
 
Les informations suivantes apparaissent dans la barre d’état au bas de la fenêtre : 

 
Les numéros (ex. : [1], [2]) représentent les touches sur lesquelles vous devez 
appuyer en même temps que la touche Contr™le/Commande. Ces raccourcis 
d’éléments ajoutent dans le script, à l’emplacement du point d’insertion, un élément 
du type indiqué dans la barre d’état. 
 
Dans un moment, nous allons saisir du texte en utilisant des raccourcis d’éléments, 
mais auparavant nous devons aborder le thème des listes SmartType.  
 
Des listes SmartType et des macros pour faciliter la saisie du 
texte récurrent 
Grâce aux touches Entrée/Retour et Tab, mais aussi aux raccourcis d’éléments, 
vous pouvez rédiger votre script sans devoir vous soucier de sa mise en forme. Final 
Draft comporte d'autres fonctionnalités qui facilitent la saisie du texte récurrent. Les 
listes SmartType permettent de saisir des noms de personnages, des extensions, 
des introductions de scènes, des emplacements, des heures et des transitions. Des 
combinaisons de touches appelées macros sont également disponibles pour ajouter 
du texte et, le cas échéant, passer en même temps à un autre type d’élément.  
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 Les listes SmartType présentent des suggestions de termes. Elles s’enrichissent 

au fil de la saisie.  
 
 Les macros sont activées au moyen de combinaisons de touches spécifiques. 
 
Nous allons poursuivre ce didacticiel en traitant des listes SmartType, des macros et 
de certains raccourcis d’éléments. Achevons la première scène de notre script en 
ajoutant un élément Transition (qui indique la fin de la scène) à l’aide d’une liste 
SmartType : 
 
11  Placez le point d’insertion à la fin du texte. 
 
12 Appuyez sur le raccourci Ctrl + 6 (Windows) ou Cmd + 6 (Mac OS). 
 
Le point d’insertion se positionne automatiquement à l’emplacement de l’élément 
Transition : 

PRÊTPOURLA
TRANSITION

 
13 Saisissez :  C (la lettre est automatiquement mise en majuscule). 
 
Une fenêtre contextuelle apparaît. Elle contient toutes les transitions qui 
commencent par la lettre î C î : 

 
 
Le ou les choix dans cette fenêtre contextuelle sont tirés de la liste SmartType des 
transitions. Lors de la création d’un script, la liste contient un certain nombre de 
transitions couramment utilisées.  
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Comme vous pouvez le constater, lorsque vous saisissez une lettre dans l’élément 
Transition, Final Draft recherche le premier choix de la liste qui correspond à cette 
lettre et î saisit î le reste du texte en gris dans le script. 
 
14 Appuyez sur la touche Entrée/Retour pour valider la sélection et passer à la 

prochaine scène.  
 
La fenêtre contextuelle dispara”t, le texte en gris devient noir et un nouvel élément 
Scene Heading (qui suit naturellement un élément Transition) est ajouté. 
 
Pour insérer le nouveau titre de scène, nous allons utiliser une macro. Les macros 
permettent de saisir du texte au moyen d’une combinaison de touches spécifique. 
Final Draft comporte vingt macros modifiables à votre convenance. Pour activer une 
macro, maintenez enfoncées les touches Ctrl + Alt ou Ctrl + Alt + Maj plus un 
numéro (Windows) ou les touches Option ou Option + Maj plus un numéro (Mac 
OS).  
 
Pour afficher l’ensemble des macros de Final Draft : 

- Maintenez enfoncées les touches Ctrl + Alt (Windows) ou la touche Option (Mac 
OS). 

 
La liste des macros associées aux touches de numéros apparaît dans la barre d’état 
au bas de la fenêtre : 

 
- Relâchez toutes les touches. 
 
- Maintenez enfoncées les touches Ctrl + Alt + Maj (Windows) ou les touches 
Option + Maj (Mac OS). 

 
Les macros supplémentaires associées aux touches de numéros apparaissent dans 
la barre d’état au bas de la fenêtre : 

 
 
 Nous allons poursuivre le didacticiel et débuter un nouveau titre de scène par le 
texte î EXT. î.  
 
Pour ajouter un titre de scène commen�ant par î EXT. î : 
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15 Appuyez sur les touches Ctrl + Alt (Windows) ou sur la touche Option (Mac OS), 
puis sur la touche î 2 î. Appuyez sur la touche Tab, puis sur la touche î D î. 

 
Le texte de la macro est inséré dans le script : 

 
L’abréviation î EXT. î est automatiquement ajoutée. SmartType a mémorisé 
l’emplacement î DARK OFFICE î (saisi précédemment) et l’insère en gris tandis que 
la fenêtre contextuelle SmartType des emplacements apparaît. Elle ne contient 
qu’un seul choix car vous n’avez jusqu’à présent saisi qu’un seul emplacement. 
L’emplacement rappelé est en gris car vous n’avez pas encore précisé à Final Draft 
si vous souhaitez le conserver.  
 
Ce n’est pas le cas en l’occurrence. Vous allez saisir un nouvel emplacement, puis 
utiliser une autre macro pour ajouter l’heure. 
 
16 Saisissez :  STUDIO LOT, puis appuyez sur les touches Ctrl + Alt + 4 (Windows) 

ou Option + 4 (Mac OS). 
 
Dès que vous appuyez sur la touche î S î, la fenêtre contextuelle dispara”t car 
SmartType ne trouve pas de choix commen�ant par î S î dans la liste. Vous pouvez 
ainsi saisir un nouvel emplacement. La macro saisit le texte î - DAY î à votre place et 
crée un paragraphe Action (car un élément Action suit généralement l’élément 
Scene Heading) : 
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LEPOINTD’INSERTION SETROUVE
DANS UN PARAGRAPHEACTION

 
Si la liste SmartType des emplacements apparaissait maintenant, elle contiendrait ce 
nouvel emplacement, prêt à être réutilisé. Ce principe s’applique également à 
chaque nouveau personnage, extension, heure ou transition saisi. Pour plus 
d’informations, consultez la section SmartType du manuel Final Draft User Guide. 
 

CONSEIL :  Il est possible de modifier à tout moment l’ensemble des macros et 
leur comportement. Consultez la section Macros. 
 
Comme nous l’avons déjà signalé, en général plusieurs méthodes sont disponibles 
pour exécuter la plupart des fonctions de Final Draft. Par exemple, pour saisir î - 
DAY î, vous auriez pu utiliser la liste SmartType de l’heure au lieu d’une macro : 
 
17 Effacez le texte saisi après le î T î de î LOT î. 
 
18 Appuyez sur la touche Tab. 
 
La liste SmartType de l’heure apparaît. 
 
19  Saisissez :  D 
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Le mot î DAY î apparaît, puis il est sélectionné dans la liste SmartType. 
 
20 Appuyez sur Entrée/Retour pour accepter le choix proposé. 
 
Le point d’insertion se trouve désormais dans un paragraphe Action. 
 
Comme vous pouvez le constater, la souplesse de Final Draft permet de choisir la 
méthode la mieux adaptée à votre style d’écriture. 
 
Enregistrez maintenant votre exemple de script. 
 
Pour enregistrer un script : 
21 Cliquez sur File > Save pour faire apparaître la bo”te de dialogue Save standard. 
 
22 Recherchez l’emplacement dans lequel le fichier doit être enregistré. 
 
Saisissez le nom du script (par exemple Essai). 
 
23 Cliquez sur Enregistrer. 
 
Enregistrement automatique et sauvegarde de sécurité 
automatique 
Pour garantir la pérennité de votre travail, Final Draft comporte des fonctionnalités 
qui enregistrent automatiquement votre texte à intervalles précis. Il crée également 
des sauvegardes de sécurité automatiques lors de l’enregistrement du document. 
Vous trouverez ciaprès un descriptif de ces fonctionnalités qui sont toutes 
paramétrables à votre convenance. 
 

REMARQUE IMPORTANTE :  Par défaut, les options Auto-Save et Auto-Backup sont 
toutes les deux activées. 
 
Pour afficher les options Auto-Save et Auto-Backup : 
Cliquez sur Tools > Options (Windows) ou Final Draft > Preferences (Mac OS X). La 
bo”te de dialogue Options (Windows) ou Preferences (Mac OS) apparaît. Cliquez sur 
l’onglet General (Windows) ou Auto-Save (Mac OS). 
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WINDOWS MAC OS

OPTIONSAUTO-SAVE/AUTO-BACKUP
 

Liste contextuelle Auto-Save every 
Lorsque cette case à cocher est activée, Final Draft enregistre automatiquement 
votre script à la fin du délai indiqué dans la liste contextuelle. Par défaut, cette option 
est activée. 
 
(Windows) Pour modifier la fréquence des enregistrements automatiques de Final 
Draft, saisissez un chiffre directement dans la zone Minutes de la fenêtre 
contextuelle. 
 
Lorsque les options Auto-Save et Ask Before sont toutes les deux activées (voir ci-
après), un message de confirmation apparaît à la fin du délai spécifié si votre script a 
été modifié depuis le dernier enregistrement. Le système vous demande 
d’enregistrer le script ou d’annuler l’enregistrement prévu. 
 

REMARQUE :  Même si le délai est expiré, Final Draft n’interrompt pas votre travail 
pour effectuer l’enregistrement. Il attend une période d’inactivité d’environ dix 
secondes avant de lancer l’enregistrement automatique.  
 
 
Option Ask before Auto-Save 
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Lorsque cette case à cocher est activée, un message de confirmation apparaît au 
déclenchement de l’enregistrement automatique (voir ci-dessus). Lorsque cette case 
à cocher est désactivée, le message n’apparaît pas et l’enregistrement automatique 
est effectué directement, au moment approprié. Par défaut, cette option est activée. 
 
 
Zone Auto-Backup  
Les options de cette zone permettent de créer une sauvegarde de sécurité de votre 
script chaque fois qu’il est enregistré manuellement ou automatiquement. Par défaut, 
cette option est activée. 
 

CONSEIL :  Cette fonctionnalité permet de î récupérer î votre travail lorsque vous 
avez modifié puis enregistré un script par mégarde. 
 
Chaque sauvegarde de sécurité est nommée d’après la convention suivante : [date] 
[heure] [nom du fichier].fdr. Par exemple, si vous avez enregistré le script Out4Life le 
15 juin 2005 à 13h37, la sauvegarde de sécurité est nommée 
200506151337Out4Life.fdr. 
 

  REMARQUE :  La sauvegarde de sécurité contient la version précédente du 
script. 
 
Liste contextuelle Backup a maximum of 
Cette option définit le nombre maximum de fichiers de sauvegarde que le dossier 
spécifié doit contenir. À chaque enregistrement, une ancienne sauvegarde de 
sécurité est automatiquement supprimée afin de ne pas accumuler trop de fichiers. 
 
Zone Backup Folder/Select New Folder 
Cette option permet de définir l’emplacement et le nom du dossier contenant les 
sauvegardes de sécurité. Par exemple, vous pouvez spécifier que les sauvegardes 
de sécurité soient enregistrées sur un autre disque dur. 
 
Présentation des fonctionnalités de production 
Les commandes et les fonctions du menu Production sont utilisées lorsqu’un script 
est transmis à la production. Les scripts de production (découpages) comportent les 
numéros de scènes, les marques de révision, ainsi que les pages de révision (pages 
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A et B, scènes A et B). Bref, sans l’aide de Final Draft, ils sont un véritable casse-
tête pour l’auteur. Final Draft inclut toutes les fonctions qui permettent d’assurer le 
suivi des modifications et de répondre aux défis que la production impose au script 
comme à l’auteur.  
 

CONSEIL :  Tous les scénaristes devraient savoir ce que devient leur script lors de 
son passage en production. Par conséquent, nous leur recommandons de lire en 
intégralité la section Production Menu du manuel Final Draft User Guide. Dans le 
cadre de ce didacticiel, nous allons exposer brièvement trois aspects du script de 
production : les scènes A et B, les pages A et B et les révisions. 
 
Les révisions conservent la trace de tous les changements apportés au script de 
production. Après l’impression, la diffusion et la modification de plusieurs centaines de 
copies d’un script, il est impératif que chaque changement soit clairement identifié. 
Lorsqu’une ligne de texte et un dialogue sont modifiés ici ou là, qu’une scène est 
ajoutée, etc., les marques de révision soulignent clairement les modifications de sorte 
qu’elles apparaissent distinctement.  
Se pose alors le problème des révisions qui altèrent la mise en forme et risquent de 
décaler les pages postérieures à chaque modification. Voyons ce qui se passe 
lorsqu’un ou deux paragraphes sont ajoutés à la page 20. Normalement, Final Draft 
devrait remettre en forme les pages qui suivent afin de laisser de la place pour le 
nouveau texte. Dans les scripts de production, cela poserait un problème car le reste 
du script devrait être de nouveau imprimé afin de prendre en compte la nouvelle 
pagination. Final Draft peut verrouiller le début de chaque page pour empêcher qu’il 
soit modifié. Si, à cause d’un paragraphe ajouté, le contenu d’une page déborde sur 
la page suivante, une nouvelle page est créée pour contenir le surplus de texte et les 
pages suivantes ne subissent aucun impact. Cette page se voit attribuer le numéro 
de la page précédente suivi d’une lettre, d’abord î A î puis le reste de l’alphabet à 
mesure de l’ajout de nouvelles pages. Dans l’exemple de la page 20 ci-dessus, la 
page suivante est numérotée 20A. Elle est suivie de la page originale 21 dont le 
contenu n’est absolument pas altéré. La page 21 n’aura pas besoin d’être 
réimprimée car elle n’a pas été modifiée. 
 
Pendant la pré-production et la production, les programmes de tournage et la plupart 
des autres tâches de coordination sont organisés par numéro de scène. Si de 
nouvelles scènes sont ajoutées, elles doivent porter les désignations A et B afin 
d’éviter toute confusion, voire un remaniement cožteux des programmes de 
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tournage. L’option Production > Scene Numbers > Numbers > Keep existing 
numbers est utilisée pour conserver la numérotation originale des scènes et pour 
créer des scènes A et B. 
 
Supposons que Out4Life soit désormais en phase de pré-production et que vous 
deviez ajouter quelques lignes à la première page. 
 
1 Ouvrez le script Out4Life. 
 
2 S’il n’est pas numéroté, faites-le (il est en production) en vous référant si 

nécessaire au paragraphe ci-dessus. 
 
Vous devez vous assurer que les pages sont verrouillées avant d’ajouter du texte. 
Activez également le mode Revision pour garantir que toutes les modifications seront 
prises en compte. 
 
3 Cliquez sur Production > Lock Pages. Un message demandant si vous voulez 

           
    activer le mode Revision apparaît. 

 
4 Cliquez sur Oui. 
 
5 Placez le point d’insertion sur la première page, à la fin de la dernière réplique de 

Bryan : 

PLACEZ LEPOINT
D’INSERTION ICI

 
6 Saisissez :  Last night was great. Let’s get together again real 

soon... I’ll call you... Maybe we can have dinner 
sometime... 

Le script ressemble maintenant à ceci : 
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MARQUESDERÉVISION

Remarque : Le nouveau texte apparaît en couleur et une marque de révision est 
insérée dans la marge de droite en face de chaque ligne modifiée.  
 
En faisant défiler le document vers le bas, vous pouvez constater que le texte 
débordant de la page 1 se trouve désormais sur la page 1A. Ainsi, la page 2 
commence toujours à la ligne où elle commen�ait avant la révision. 
 
7 Faites défiler le document jusqu’à la page 2 et placez le point d’insertion à la fin 

du texte de la scène 2 : 
 

PLACEZ LEPOINT
D’INSERTION ICI

 
 
8 Pour créer un nouveau titre de        

  scène, appuyez sur Ctrl + 1 (Windows) ou sur Commande +1 (Mac 
OS). 

 
9 Saisissez : I, puis appuyez deux fois sur la touche Tab. 
 
La liste SmartType des emplacements apparaît : 

 



FINAL DRAFT INTERNATIONAL EDITION 
 

71 – Premiers pas 
 
 
 

 

10 Utilisez la flèche vers le bas pour sélectionner î BRYAN’S CAR - PHILADELPHIA 
STREETS î et appuyez sur la touche Entrée/Retour. 

Remarque : Ce texte apparaît également en couleur et une marque de révision est 
insérée dans la marge de droite. Au lieu de poursuivre la saisie, effectuez les 
opérations suivantes : 
11 Cliquez sur Production > Scene Numbers. 
 
12 Activez la case à cocher Add numbers. 
 
Remarque : La case à cocher Keep existing numbers est activée également. 
 
13 Cliquez sur OK. 
 
Remarque : La nouvelle scène est maintenant correctement numérotée (2A). Toutes 
les autres scènes conservent leur numérotation d’origine. 

 
Comme le démontre cette brève introduction, la gestion des scripts de production 
peut être source de nombreuses difficultés. Heureusement, Final Draft est disponible 
pour tout régler à votre place. 
 
Pour aller plus loin 
Nous venons d’explorer rapidement quelques fonctionnalités de base de Final Draft. 
Comme vous pouvez le constater, de nombreuses options permettent de saisir des 
phrases récurrentes et d’agencer les éléments de scénario en toute facilité.  
 
Final Draft est fourni avec de multiples fonctionnalités utiles et puissantes qui ne sont 
pas abordées dans cette section. Par conséquent, nous recommandons de lire 
l’ensemble des sections du manuel Final Draft User Guide. La version complète du 
manuel Final Draft User Guide (en anglais uniquement) figure dans le dossier Final 
Draft 7 au format Adobe Acrobat (PDF). Elle est accompagnée de nombreux autres 
didacticiels. 
 
N’oubliez pas qu’il existe bien souvent plusieurs fa�ons de saisir du texte ou 
d’appliquer une mise en forme. L’ajout d’un nouvel élément (quel que soit son type) 
peut s’effectuer à l’aide des touches Tab et Entrée/Retour, des raccourcis 
d’éléments utilisant les touches Contr™le/Commande ou d’une macro. 
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Prenez donc le temps de vous familiariser avec Final Draft, y compris en vous 
amusant. N’hésitez pas à vous exercer avec une copie de l’exemple de script 
Out4Life ou avec l’un de vos scripts. 
 
Explorez tous les menus et les fonctionnalités de Final Draft. Ainsi, vous serez 
capable de choisir le mode d’utilisation le mieux adapté à votre fa�on de travailler. 
 
Quelle que soit votre tâche – élaboration, rédaction, voire réécriture de scripts – vous 
réaliserez combien ces fonctionnalités sont précieuses. Vous êtes sans doute 
capable d’écrire un script complet et parfaitement mis en forme simplement en 
utilisant les techniques de base traitées dans ce document. Pourtant, n’oubliez pas 
que ce didacticiel ne fait qu’effleurer les possibilités de Final Draft, un outil puissant 
grâce auquel vous pouvez écrire avec moins d’effort que jamais. 


